Contents

Unit Overview .......................................................................................................................... 2
  Overview ............................................................................................................................... 2
  Objectives ........................................................................................................................... 2
  Exercises ............................................................................................................................. 2
  Key Terms .......................................................................................................................... 2
Lesson 1: User Interface ........................................................................................................ 3
  Lesson Overview ................................................................................................................ 3
  Revit Structure: Features and Concepts to Learn ............................................................. 3
Lesson 2: Collaboration Tools ............................................................................................. 10
  Autodesk 360 ................................................................................................................... 10
  Autodesk 360 Home Page ............................................................................................... 10
  Autodesk 360 Documents Page ....................................................................................... 11
Lesson 3: Autodesk Design Review .................................................................................... 12
  Lesson Overview ................................................................................................................ 12
Exercises Overview ........................................................................................................... 15
  Exercise 2.1: User Interface Tutorial ............................................................................... 15
  Exercise 2.2: Grids and Levels ......................................................................................... 15
  Exercise 2.3: Columns, Beams, Joists ............................................................................ 15
  Exercise 2.4: Braces ........................................................................................................ 15
  Exercise 2.5: Sheets and Drawings ................................................................................ 16
  Exercise 2.6: Exporting DWF Files ................................................................................ 16
  Assessment Questions ..................................................................................................... 16

www.autodesk.com/edcommunity
Unit Overview

Overview
This unit introduces the basics of BIM design as implemented in Autodesk® Revit® Structure 2013 user interface (UI). Revit Structure’s design simplifies your workflow. This unit explains why the Revit Structure environment is new to a CAD user. To help familiarize them with the software, students will practice placing several components and modifying their properties in Revit Structure.

Objectives
After completing this unit, students will be able to:

- Define the Revit Structure user interface.
- Define the Autodesk® 360 user interface
- Define the Autodesk® Design Review user interface
- Define the AutoCAD® WS user interface

Exercises
The following exercises are provided for the students:

- Exercise 2.1: Interface and Terminology
- Exercise 2.2: Starting a Project
- Exercise 2.3: Columns, Beams, and Joists
- Exercise 2.4: Braces
- Exercise 2.5: Sheets
- Exercise 2.6: Exporting DWF Files
- Exercise 2.7: Challenge Exercise Overview

Key Terms
The following terms are used in this unit:

<table>
<thead>
<tr>
<th>Key Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cloud</td>
<td>The ability to access information from a third-party server by using the Internet.</td>
</tr>
<tr>
<td>Autodesk 360</td>
<td>Autodesk 360 is a cloud-based platform that gives you access to storage, a collaboration workspace, and cloud services to help you dramatically improve the way you design, visualize, simulate, and share your work with others anytime, anywhere.</td>
</tr>
<tr>
<td>AutoCAD WS</td>
<td>Open and edit DWG™ files with just a web browser and from any computer. Manage and edit drawing files using a powerful set of AutoCAD® tools</td>
</tr>
<tr>
<td>Autodesk Design Review</td>
<td>It’s the free, all-digital way to view, mark up, print, and track changes to Autodesk 2D and 3D files—without the original design software.</td>
</tr>
</tbody>
</table>
Lesson 1: User Interface

Lesson Overview

The Revit user interface comprises several screens, panels, and toolbars that facilitate project organization. For example, the Project Browser has places for structural plans, 3D views, and elevations. The Project Browser also contains more complicated aspects of Building Information Modeling that include legends, schedules, quantities, and sheets.

Revit software’s UI also has a Quick Access toolbar at the very top of the ribbon, a status bar in the lower-left corner, visibility controls, and a comment area that shows you where you are in the model.

Revit Structure: Features and Concepts to Learn

The following image introduces the Revit Structure user interface.

![Figure 2.1: Revit Structure's Graphical User Interface (GUI) Home screen.](image)

When you open a project in Revit Structure, you will see something similar to the above picture. You will do most of your work in this area. Refer to Figure 2.1 above as you read about each GUI element below.

www.autodesk.com/edcommunity
Revit Application Menu (1)

The Application menu provides access to common file actions, such as, New, Open, and Save. It also helps you manage files using Export and Publish. Click the R on the top-left corner of the user interface to open the Application menu as shown in Figure 2.2 below.

![Figure 2.2: The Application menu.](image)

Revit Quick Access Toolbar (2)

The Quick Access toolbar contains a set of default tools. You can customize this toolbar to display the tools you use most often.

![Figure 2.3: The Quick Access Toolbar (QAT) default view in Revit.](image)

The QAT can be placed above (system default) or below the ribbon. You can add tools to it. For instance, you can add the Grid tool by right-clicking the tool and clicking Add to Quick Access Toolbar (Figure 2.4). This makes the QAT easy to customize.

![Figure 2.4: Add the Grid tool (and many others) to the Quick Access toolbar by (1) hovering over the tool in the ribbon and right-clicking, (2) and then selecting Add to Quick Access Toolbar to make the tool appear in the QAT.](image)

www.autodesk.com/edcommunity
InfoCenter Bar (3)

The InfoCenter bar provides quick access to resources at Autodesk.

![InfoCenter bar](image)

**Figure 2.5: InfoCenter bar.**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Live Update Maintenance Patches</td>
<td>Receive automatic notifications whenever Autodesk releases new maintenance patches.</td>
</tr>
<tr>
<td>Subscription Information and Extension Announcements</td>
<td>Get announcements and Autodesk® Subscription program news if you are an Autodesk Subscription member.</td>
</tr>
<tr>
<td>Articles and Tips</td>
<td>Receive notifications when new articles and tips are available on Autodesk websites.</td>
</tr>
<tr>
<td>Product Support Information</td>
<td>Get breaking news from the Product Support team at Autodesk.</td>
</tr>
<tr>
<td>Welcome Wizard</td>
<td>Use the Welcome Wizard to set Communication Center for your country/region, update frequency, and the information channels you want.</td>
</tr>
<tr>
<td>Autodesk 360</td>
<td>Use this link to log into your Autodesk 360 account.</td>
</tr>
</tbody>
</table>

Options Bar (4)

The Options bar default location is between the Ribbon and the Draw Space. Its contents change depending on the current command or selected element.

To move the Options bar to the bottom of the Revit Structure window (above the status bar), right-click the Options bar, and click Dock at bottom.

![Options bar](image)

**Figure 2.6: Options bar.**
Type Selector (5)

The Type Selector is part of the Properties Palette and is located between the Options bar and the Project Browser. Its contents change depending on the current function or selected component. When you place a component in a drawing, use the Type Selector to specify the type of component to add. When you select an existing component, use the Type Selector to change its type by clicking on the arrow (see Figure 2.7.)

Figure 2.7: Type Selector dialog box.

When a tool for placing elements is active, or you select elements of the same type in the drawing area, the Type Selector displays at the top of the Properties Palette. It identifies the currently selected family type and provides a drop-down menu (see Figure 2.8) where you select the type you want.

Figure 2.8: Type Selector dialog box: Use the drop-down arrow to change an element type.

Properties Palette

The Properties Palette is a modeless dialog box where you can view and modify the parameters that define the properties of elements in Revit. When the Properties Palette is open during a Revit project, it enables you to:

- Select the type of element to place in the drawing area or change the type of an element already placed.

www.autodesk.com/edcommunity
View and modify properties of the element you are placing, or view and modify the elements selected in the drawing area.

- View and modify the properties of the active view.
- Access the type properties that apply to all instances of an element type.

**Project Browser (7)**

The Project Browser shows a logical hierarchy for all views, schedules, sheets, families, groups, and linked Revit models in the current project. As you expand and collapse each branch, lower-level items display. You can organize the Project Browser in a variety of ways, making large projects easier to manage.

![Project Browser](image)

Figure 2.9: Project Browser.

**Status Bar (8)**

The status bar is in the lower-left corner of the Revit Structure window. When you are using a command, the status bar provides tips or hints on what to do (Figure 2.10). When you are highlighting an element or component, the status bar displays the name of the family and type (Figure 2.11).

![Status bar displaying commands](image)

Figure 2.10: Status bar displaying commands.

![Status bar displaying family name and type](image)

Figure 2.11: Status bar displaying family name and type.

**View Control Bar (9)**

The View Control bar is located at the bottom left of the Revit Structure window above the status bar. It provides quick access to functions affecting the drawing area. Each function provides an array of options making it easier to control the visibility of your projects.

- Scale
- Detail Level
- Visual Style
- Sun Path On/Off
- Show/Hide Rendering Dialog Box
- Shadows On/Off
- Crop View
Draw Space (10)

The Draw Space (see Figure 2.12), or drawing area, of the Revit window displays views (isometric, plans, sheets, details, sections, and schedules) of the current project. Each time you open a view in a project, by default, the view displays in the drawing area on top of any other open views.

You can have different windows open (see Figure 2.13) and use commands from the Window menu within Revit to arrange project views to suit your work style.

Figure 2.12: Draw Space with no windows open.

Figure 2.13: Draw Space with multiple windows open.

Ribbon

The Ribbon (see Figure 2.14) displays when you create or open a file. It provides the majority of the tools necessary to create a project or a family. Each tab in the Ribbon holds a menu of different functions related to the model you have open.

Figure 2.14: The Ribbon menu.

www.autodesk.com/edcommunity
<table>
<thead>
<tr>
<th>Tab Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Structure</td>
<td>Displays by default on the Home screen. Your most-used tools are here.</td>
</tr>
<tr>
<td>Architecture</td>
<td>Displays building façade components and other architectural-related items.</td>
</tr>
<tr>
<td>Insert</td>
<td>Enables you to import images and information from other software platforms.</td>
</tr>
<tr>
<td>Annotate</td>
<td>Enables you to enter dimensions and text for the current model.</td>
</tr>
<tr>
<td>Analyze</td>
<td>Displays the structural engineering aspects of the model.</td>
</tr>
<tr>
<td>Massing &amp; Site</td>
<td>Displays civil site functions.</td>
</tr>
<tr>
<td>Collaborate</td>
<td>Provides tools used to interact with internal and external teams. Aids in</td>
</tr>
<tr>
<td></td>
<td>coordination.</td>
</tr>
<tr>
<td>View</td>
<td>Creates views of the model that display information.</td>
</tr>
<tr>
<td>Manage</td>
<td>Controls how the model behaves and works with other models.</td>
</tr>
<tr>
<td>Modify</td>
<td>Enables you to modify a particular element in the model.</td>
</tr>
</tbody>
</table>

On the Select row, there are expandable panels (see Figure 2.15) and dialog launchers (Figure 2.16). An expandable panel displays tools related to the element tool in the section above it. You can recognize it by the diagonal arrow in the panel's right corner. A dialog launcher displays defined settings related to the element tools above it. Each dialog launcher has a drop-down arrow next to its name.

![Figure 2.15: Expandable panel.](image)

![Figure 2.16: Dialog launcher.](image)

**Structural Analysis**

Structural analysis provides Revit users with the capability of performing complex structural analysis. The section circled in red, below, enables users to send analytical models to the cloud for computing.

![Analyzing in the cloud](image)
Lesson 2: Collaboration Tools

**Autodesk 360**

Autodesk now offers storing and sharing information in the cloud with one of their latest products, Autodesk 360. With Autodesk 360 you can upload project files to an online storage area for team members and project participants. This enables them to view the documents free of charge. Users also have the ability to comment on and mark up plans as needed through Autodesk Design Review and AutoCAD WS (these products are discussed later).

The power of cloud computing can be extremely helpful when large tasks such as structural analysis come into play. With Revit Structure 2013, engineers can now extend design models from Revit to the cloud for structural analysis. Engineers can perform static analysis from within Revit to help streamline the design process. Within a matter of minutes, analytical information can be implemented into the model. (Revit structural analysis is explained in more detail in unit 4).

With Autodesk 360, collaboration is easier and more efficient than ever before. The only information you need for these features is an email address. The Figures 2.17 and 2.18 illustrate basic features you need to know to operate Autodesk 360.

**Autodesk 360 Home Page**

![Figure 2.17: You can upload and download projects from the Documents tab (1). From the Home tab you can see who has downloaded or uploaded previous documents (2).](image-url)
Figure 2.18: The Create new folder icon enables you to add and organize projects accordingly (1). Right-click on an existing folder to see different options. An important one to note is the Share option. This enables the owner of the files to share folders all team members, or selected individuals (2). Use the up arrow icon to upload projects and documents (3).
Lesson 3: Autodesk Design Review

Lesson Overview
Accessing models and drawings from a client can be difficult unless you own the specific software to open them. With Autodesk Design Review, this is no longer a problem. With Autodesk Design Review, you can not only open different file types, but you can mark up, print, and track project drawings from a desktop or mobile device.

With Autodesk Design Review’s mobile app, you can download drawings from Autodesk 360, view drawings in the field, mark up drawings as needed, and upload drawings back to Autodesk 360 for further collaboration. Figure 2.19 is an example of Autodesk Design Review in use.

Home Page

Figure 2.19: A CAD file has been marked up and reviewed in Autodesk Design Review.

Application Button

Figure 2.20: From the Application button (1) you can see a CAD file opened in Autodesk Design Review. You can open 2D and 3D drawings; however, the 3D drawings must be DWF™ files.
Stamps

Figure 2.21: Different stamps for helping the review process.

Autodesk 360 Accessibility

Figure 2.22: You can access Autodesk 360 by clicking the button highlighted above. Autodesk Design Review takes you to your projects that are available on Autodesk 360.
AutoCAD WS
AutoCAD WS is another free mobile app that is a light version of AutoCAD. While it has features of AutoCAD, it does not contain the full application. It has the capability of opening DWG, DXF™, DWF, and PDF files. You can view, edit, mark up, and print any of the drawings with a select few of AutoCAD's tools. As in Autodesk Design Review, you can send documents to the cloud for others to access. Figure 2.24 is an inside look at AutoCAD WS.

Figure 2.23: AutoCAD WS.
Exercises Overview

To complete the following exercises, students will need online access to the Autodesk BIM Workshop (www.autodesk.com/bimworkshop). Click on the Structural Engineering tab and select Unit 2. They will also need headphones if they are in a lab setting among other computers.

![Sample Revit Structure model](image)

**Figure 2.24: Sample Revit Structure model.**

**Exercise 2.1: User Interface Tutorial**

Ask students to identify the various components of the user interface and describe what those components are used for.

**Exercise 2.2: Grids and Levels**

Ask the students to describe the importance of grids and levels in Autodesk Revit Structure.

Their answers should highlight the fact that almost all structural elements are attached and move with grids or elements.

**Exercise 2.3: Columns, Beams, Joists**

After placing the gridlines in the last exercise, we will start adding some structural members such as columns, beams, and joints.

What are the two ways you can place a column or beam?

Discuss how structural engineers design beams, columns, and floors and calculate the loads of each member and the load capacity of various building materials. Should they consider moisture, heat and energy inside the building components?

**Exercise 2.4: Braces**

What is the best order to build structural framing members?

Answer should typically be as follows:

- Level
- Grids
- Columns

www.autodesk.com/edcommunity
**Exercise 2.5: Sheets and Drawings**

What is the role of general notes and typical details in construction documents?

Answers should include the concept of documenting structural information that is not modeled or fully documented in the objects that are modeled. As an example, most building codes require that the structural drawings identify the seismic site class of soil that the building is located on. Currently, this is information that is not modeled in 3D or assigned to any metadata of 3D objects and, thus, is typically addressed in a project's general notes.

**Exercise 2.6: Exporting DWF Files**

What are some advantages of using DWFx files to create sheets?

Make a new project and then experiment with it. Tile a plan view along with an elevation and 3D views. Establish walls. Place windows and doors. Add a floor and a ceiling. Now make several different modified versions of your design. How long did all this take you? How long would it have taken you in a CAD program?

Use the File menu to start different projects with the various templates provided.

Notice the differences between the templates. Search the Help menu to see how templates are made.

Have the students talk about what they learned in this exercise and how these templates can be useful as they move forward with Revit.

**Assessment Questions**

What is the difference between the Options bar and the toolbars?

*Answers should include the Option bar changes depending on what tool is selected while almost all of the ribbons do not change the tools available.*

Why are some parameters available but not others from the Options bar?

*See answer above. It is because the Option bar changes based on the tool that is used.*

What functions does the Project Browser perform?

*The Project Browser shows all of the associated objects in the project.*